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DESCRIPTION OF EXCEL ANALYSIS TOOLS AVAILABLE
The table below lists some of the tasks you may wish to accomplish using Excel and some of the methods available
to utilize.

WHAT DO YOU WANT TO DO?

METHODS YOU CAN USE


View Matching Records:
 Compound Criteria.
 No Statistical Data Needed.

Filter
Located under the “Data” tab. Filter allows you to hide records
which do not match your criteria. Criteria can be matching or
ranges of text, values, or dates. You can also filter by more than one
column.

Use these methods if you wish to view the
actual records which match your criteria.
You do not need to perform any statistical
operations.



Advanced Filter
Similar to the regular “Filter”, you would probably only use this if
you are using the Database functions or wish to copy the matching
records to another location.



View Matching Records:
 Compound Criteria.
 Display Statistical
Information.



Filter & Tables

If you convert your database into a “Table”, there are “subtotal”
functions you can easily use to place counts, averages, sums, etc., at
the bottom of the table. If you combine this with the “Filter”
function, the subtotals will up to display only matching criteria.

Database Functions with the Advanced Filter

When using the Advanced filter, you can also use Excel’s database
functions such as Dsum(), Daverage(), Dcount(), etc., to display
statistical information.



Compute Statistical Information:
 No Criteria Needed.
 Don’t Need to See Records.
Of the solutions offered to the right,
PivotTables are the easiest to use but store
the solutions in a PivotTable matrix which
may not be what you want. They also use
a lot of memory so if you need multiple
answers, they may not be the best
solution.
Tables are also easy to use and can give
you subtotals. The subtotals appear below
the last row of the table which like
PivotTables, may not be where you want
them.
The functions listed are simple formulas
that can be typed in any location in the
workbook.
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PivotTables
Located under the “Insert” tab. PivotTables quickly summarize
your data into a matrix consisting of a column heading and or row
heading. PivotTables summary operators include Count, CountA(),
Average, Sum, and Standard Deviation. PivotTables can be created
on the same sheet or a different sheet from your database.

Tables
If you convert your database into a table, there are “subtotal”
functions you can easily use. The subtotal functions appear below
the last row of the table (database).

Count()
Counts the number of cells in a given range which contains values.
Ignores text and blank cells.



CountA()
Counts the number of cells in a given range which contains Values
or Labels. Ignores blank cells.




Average()

Finds the average if a range of cells. Ignores blanks cells and cells
containing text.

Sum()
Adds values in a range of cells together.
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WHAT DO YOU WANT TO DO?

METHODS YOU CAN USE

Compute Statistical Information:
 Single Criteria Only.
 Changing the criteria for the
current answer does not
change the previous ones.
 Don’t Need to See Matching
Records.
One problem with PivotTables and Tables
is that if you change your criteria, all of
your solutions change. If you need to see
the solutions to various different criteria
at the same time, this can be a problem.
While you can create multiple PivotTables
and Tables, they both can eat up a lot of
memory.
The functions to the right contain the
criteria within the function and do not
require you to filter the database. They
can be typed within any cell.

CountIF() – Single Criteria
Counts the number of cells whose contents match a single given
criteria. Works with text or values. For example: “Count all the
cells that have the word “Female” in them”. Or “Count all the cells
containing a value greater than 50”.



AverageIF()– Single Criteria
Returns the average values in a range(s) of cells given a single
given criteria. For example: “Average all the cells that have the
word “Female” in them”.



SumIF()– Single Criteria
Sums the contents of cells containing values that match a given
criteria. For example: “Sum the expense accounts for Managers
only.”

IF()
You may be tempted to use an IF() statement rather than CountIF or
AverageIF(); however, this won’t be possible without entering it as an
Array formula. Array formulas are covered later.



Compare Separate Columns
 Complex Criteria.
 Changing the criteria for the
current answer does not
change the previous ones.
 Don’t Need to See Matching
Records.
Use Multiple Criteria:
 Complex Criteria.
 Changing the criteria for the
current answer does not
change the previous ones.
 Don’t Need to See Matching
Records.

IF() & AND() & OR()
If you need to compare different columns, you may wish to
consider using an IF() statement. It can contains formulas,
functions, and is capable of AND and OR conditions.

If you have criteria based on more than
one column, you don’t need to see the
matching records, and you don’t want
pervious results to change when you filter
your database, use the techniques listed to
the right.
Limitation:
Note that all three functions to the right
require 1 column of criteria and 1
corresponding column of data to count,
average, or sum.
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CountIFS() – Multiple Criteria



AverageIFS() – Multiple Criteria

The difference between CountIF() and CountIFS() is that CountIFS()
can have multiple criteria. For example: “Count the number of
males over the age of 50.”
Note that CountIFS() uses 1criteria column and 1column of data to
count. It cannot count a block of data.

The difference between AverageIF() and AverageIFS() is that
AverageIFS() can have multiple criteria. For example: “Display the
average salaries of males over the age of 50.”
Note that AverageIFS() uses 1criteria column and 1column of data
to average. It cannot average a block of data.



SumIFS() – Multiple Criteria
The difference between SumIF() and SumIFS() is that SumIFS() can
have multiple criteria. For example: “Sum the expense accounts for
Managers and Directors.”
Note that SumIFS() uses 1criteria column and 1column of data to
average. It cannot average a block of data.
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WHAT DO YOU WANT TO DO?

METHODS YOU CAN USE


Complex Criteria & Compute Blocks
of Data:
 Complex Criteria.
 Changing the criteria for the
current answer does not
change the previous ones.
 Don’t Need to See Matching
Records.
 Compute Blocks of Data.

Array Formulas
Array functions have two major advantages over many of the
functions listed above:
o They can perform their operations on blocks of data rather
than a single column.

If you need to perform computations on
multiple columns of data using a column of
conditions, then an Array function may be
your solution. They are custom formulas
that process the cells in ranges
individually rather than in aggregate.
Often, they can also be used to compute an
answer that would take two or more steps
in one formula.

o Because you design them yourself, they are very
adaptable.
o They can be combined with other functions.
The disadvantages of array functions are:
o They can be conceptually complex to create.
o You must remember to press Control + Shift + Enter
after typing or editing them for them to return to
correct response.
Example: You wish to count how many salaries are greater than
the average salary.

Summary of Tools Available and their Properties

Filter
Filter & Tables
PivotTables
Advanced Filter
Count()
CountA()
CountIF()
CountIFS()
Average()
AverageIF()
AverageIFS()
Array Formulas

View
Matching
Records
Yes
Yes
No
Yes
No
No
No
No
No
No
No
No

Allows
Single
Criteria
Yes
Yes
Yes
Yes
No
No
Yes
Yes
No
Yes
Yes
Yes

Allows
Multiple
Criteria
Yes
Yes
Yes
Yes
No
No
No
Yes
No
No
Yes
Yes

Can
Compute
Statistical
Information
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Previous
Results
Stable when
the Criteria
Changes
No
No
No
Yes *
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

* It is possible to create multiple criteria areas using the Advanced Filter. This will allow you to save your
statistical results.
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EXPORTING A QUALTRICS SURVEY TO EXCEL (As a .CSV File)
This section covers some of the options available when exporting survey results as a .CSV file (Comma Separated
Values) which can be read by Excel. To access the download area, follow these steps:
1. Login to Qualtrics.
2. Click the “View Results” tab.

3. Select the folder
containing your survey.
4. Select your survey.

5. Click “Download Data”.

Prior to exporting, there are six options you will need to address. They are briefly listed here and are illustrated
over the next few pages. A few additional options follow this section.
 Questions to Export – Would you like to export all of your questions or just specific ones?
 Date Range – Would you like to export all questions or just ones from surveys answered within a
specific period?
 Answer Representation – For multiple choice questions, you can instruct Qualtrics to export the
answer choices as they appeared on the survey or convert them to a numeric equivalent.
 or would you like to supply short descriptive names?
 Recode Values – This pertains to unanswered but seen questions. (Unseen questions would be ones
which appeared on a branch the user didn’t go down or hidden through skip logic.) Unanswered
questions appear as blank cells but you can have Qualtrics fill in a value instead.
 Export Tags – Above each column of answers, would you like Qualtrics to simply number each column
Format – In this handout, the format we are exporting to is an Excel .CSV file but there are other
possible formats you could use.
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1. Select Questions
Use this area to specify the questions (and results) you
would like to include in the export.
 All Questions – Click this to export all questions.
 Control + Click to select non-adjacent
questions.
 Shift + Click to select adjacent questions.

2. Date Range (Optional)
If desired, you can use this to specify that only responses within
the given time period should be exported. Leave blank to export
all responses regardless of the date they were recorded.

3. Answer Representation (Labels or Values)
For multiple choice questions, you can instruct Qualtrics to
export the answer choices as they appeared on the survey or
convert them to a numeric equivalent.
For example, let’s say you asked
the question shown below.

See the section “More Export
Options: Recoding Values &
Variables” for more on
controlling how responses
appear in the export.

Answers as Labels – If you export “as
Labels”, the answer text appears in
the column as shown to the right.

Answers as Values - If you select
“Values”, then text answers are
converted to numeric choices. For
example, Finance is 1, Marketing is 2,
and Accounting is 3 as shown to the
left. Do not use “as Values” for
Constant Sum questions because the
answers will be meaningless.

4. Recode Values (Optional)
This pertains to unanswered but seen questions.
(Unseen questions would be ones which appeared on a
branch the user didn’t go down or hidden through skip
logic.) Unanswered questions appear as blank cells but
you can have Qualtrics fill in a value instead.
To use this option, check the box and then type
whatever characters you would like to appear in the
download in the box.
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5. Question Numbers vs. Export Tags
For exported surveys, you have the choice to export the question numbers or descriptive titles as column headings.

Question Numbers
When you export to Excel, your question
numbers will become the column headings for
each response.

Export Tags
If you would like something more descriptive than a
number as your column heading, you can create an
Export Tag for each question. An export tag is simply
text or values which appear as the column heading for
each question in your export. To create and utilize
Export Tags, follow the steps below.

Away From Home

a.
b.
c.
d.
e.

Go to the “Edit Survey” tab.
Click each question’s number and type as desired.
Go to the “View Results” tab
Click the “Download” data button.
Check “Yes” at “Export tags:”.

Note that if you created export tags but do not check “Yes” to use them as we did in step e, Excel will
number each column using this format: V1, V2, V3, etc.

6. Format
In the final step, you need to click the Excel icon to export your survey as a .CSV
(Comma Separated Values) which can be read by excel.
a. Click the “Excel” icon.
b. Excel will prompt you to either “Save” or “Open”.
 Excel 2007 – Click either Save or Open.
 Excel 2003 – Click Save and then open the file from within Excel.
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MORE QUALTRICS EXPORT OPTIONS
There are a few other export options you may find useful, these include exporting shorter versions of your
questions (Static Labels) and answers (Variable Naming) or recoding answers when exporting Answers as Values.

Static Labels (Shorter Exported Question Text)
For each survey response, the second row in Excel always contains the question text. For lengthy questions and
matrix questions, this can be cumbersome because it isn’t easy to view the entire question on the screen. An
alternative is to create a “Static Label” which is basically just a shorter version of the question which shows up in
the export in place of the question text. Note that the responders still see the full question text in the survey.
For example, the
matrix question shown
to the right will
normally export to
Excel as shown below.
Follow the steps below
to create Static Labels.

1.
2.
3.
4.
5.
6.

Click the “Edit Survey” tab.
Click the question you wish to affect.
Click the question’s purple box.
Select “More Advanced Options”.
Click the “Preview & Label” tab.
Check “Specify a static label”.

7. Type a short title for the question.
8. Click “Save Question”.

V19

V20

© Marshall School of Business - Wayne Wilmeth

Results of using Static Labels
When you export to Excel, the question text will be
replaced with what you typed in the “Specify a static label”
box.
Note that the person taking the survey will still see the full
question text. Note also that unlike Export Tags, there is
no option to turn this off or on for the export. If you
wanted to export the full question text, you would have to
go back to each question and check “Use Question Text”.
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Recode Values & Variable Naming (Shorter Answer Text or Number Recoding)
Earlier we mentioned that
answers can be exported as the
actual text answers the
responder sees or as a numeric
value. This section goes a little
bit further by showing you how
to export a shorter text
description of the answer
(Variable Naming) or if you are
exporting as values, how to
change the numbering (Recode
Values).
Variable Naming (text)
In the images to the right, the
“before” image shows how the
answers would normally export
as labels.
The “after” image shows the
same results only this time,
Variable Naming was used to
create the shorter answers of:
Supportive, Enigmatic, and
Mixed.
To export the variable names,
you must export “Answers as
Labels”.

Recode Values (numbers)
If you are exporting as values,
you can use “Recode Values” to
control what those values
would be. The Before image on
the left shows how the answer
exported as values but not
recoded would appear. The
After image shows how the
answers would appear after
recoding.
If you use Recode Values, you
must export “Answers as
Values” to see them.

Answers Before “Variable Naming”

Answers After “Variable Naming”

Answers Before “Recode Values”

Answers After “Recode Values”

See the next page for instructions on how to setup both “Recode Values” and “Variable Naming”.
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Steps for Recoding Values and Variable Naming
Follow the steps below to either Recode Values or use Variable Naming. Please not the following:
 This must be done on a question-by-question basis.
 To disable recoding or renaming, you must also do that on a question-by-question basis. It is not like export
tags where you can easily turn it on or off.
 If you “Export as Values”, the Recoded Values will be in export.
 If you “Export as Labels”, the Renamed Variables will be in the export.
1.
2.
3.
4.

Click the “Edit Survey” tab.
Click a question.
Click its purple button.
Select “Recode Values…”.

5. Check “Recode Values” or “Variable Naming” or both
depending upon what you wish to do.

6. If Recoding Values, type
in a new number for
each question.

7. If Variable Naming,
type some text for
each question.

8. Click “Close”.

9. If desired, do the same for more questions.
10. When you export, either select “Answers as Labels” if you wish to export your
“Variable Names” or select “Answers as Values” if you wish to export your
“Recoded Values”.
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ANALYZING MULTIPLE CHOICE QUESTIONS IN EXCEL – SINGLE ANSWER
Also known as “Radio” buttons, when using this
question type the user can only select one of the
possible choices. When exported to Excel, multiple
choice single answer questions appear in a single
column. The image below shows data exported as
“labels” but the techniques shown in these examples
works for data exported as “values” as well. Some of
the analysis techniques you can use include:





PivotTables
CountIF()
AutoFilter in combination with the Subtotal() function. (Shown later)
An array formula to determine the number of people selecting each
response. (Shown later)

Solution 1: Using Pivot Tables
Pivot tales are perhaps the fastest method of calculating results as long as you don’t need
to see the actual rows of matching data.
1.
2.
3.
4.

Click the “Mult_Choice_Single_Answer” sheet.
Highlight A3:A14.
Click the “Insert” tab and then click “Pivot Table”.
Specify
destination
and(What
click “OK”.
Drag
thea column
header
is your Major) into the “Row Labels”
box and also into the “Values” box.
This should produce the pivot table shown below.

5. If it is summing instead of counting,
click the “values” drop down and
select “Value Field Settings”.
6. Select “Count” from the list and
click “OK”.
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Solution 2: Using CountIF()
Excel’s Countif() function allows you to count the
number of times a specific word or number
appears in a range of cells.
Syntax:

=Countif(Range,"Criteria")

This is the items
you are counting.

This can be text (in quotes),
numbers, a cell address, or a
Boolean equation i.e. “>=3” (in
quotes). It cannot contain
formulas or functions.

1. Click the “Mult_Choice_Single_Answer” sheet.
We have typed the three different possibilities in cells
A17:A19 and will use these cell addresses as the criteria
in the CountIF() function. This enables us to only have
to type the formula once and then copy it.
2. Click in cell B17.
3. Type the following: =Countif(A$3:A$14,A17)
(The $ signs are to prevent the range A3:A14 from
shifting down when we copy down.)
4. Copy the formula to B18 & B19.
This tells us that the word Finance exists 5 times,
Accounting 4, and Marketing 3 in the range A3:A14.
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MULTIPLE CHOICE WITH “ALLOW TEXT ENTRY”
When you couple a multiple choice question with “Allow Text
Entry” so a user can write in their own choice, the question will
export additional columns to Excel for what the user wrote in.
This is true for single and multiple answer questions. In the
example below, in row 8 and 11, users selected “Other” and
typed in their own major. The text they typed in is stored in the
column next to it.
1. Click the “Mult_Choice_Other” sheet.

Possible Solutions
You can use both CountIF() and PivotTables as shown in the previous to display the number of responders who
selected each choice: Finance, Marketing, Accounting, or Other. If you need to see what the actual write in
responses for “Other” is, use “Filtering” which is covered a little bit later.
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MULTIPLE CHOICE/MULTIPLE ANSWER – TOTAL COUNT PER COLUMN
When
using this
questionboxes,
type the
user
can this
any question
number of
thethe
possible
choices.
Also known
as “check”
when
using
type
user can
select
one more than one of the possible choices. When exported to Excel, each possible
response is in a separate column.
1. Click on the “Mult_Choice_Mult_Answer” sheet.
In the example, there are three possible responses so there are three columns for
the question. If the responder selected a choice, their choice will be in the cell;
otherwise, the cell will be blank. For example, the person in row 3 checked
“Athletics” and “Arts/Entertainment” but did not select “Autos”.

We wish to know the total number of times each item was selected. Suggested Solutions:
 CountA()
 PivotTables

Solution 1: Counting a Column’s Total Responses - CountA( )
Excel’s CountA() function will count the number of cells in a range which contain either text or numbers. It does
not count blank cells but does count cells which contain a zero. It differs from Count() in that Count() will only
count cells with numbers while CountA() will count cells with number or letters.
Syntax:

=CountA(range)

1. Click the “Mult_Choice_Mult_Answer” sheet.
2. Click in cell A9 and type the following: =CountA(A3:A8)
3. Copy A9 to B9, and C9.
CountA() should return the number of non blank cells for each
column giving you the number of people who checked Athletics (4),
Arts/Entertainment (3) and Autos (3).
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Solution 2: Counting a Column’s Total Responses - PivotTables
You can also use PivotTables to count the number of items in columns by dragging each column heading into the
Values area of the PivotTable.
1.
2.
3.
4.

Click the “Mult_Choice_Mult_Answer” sheet.
Highlight A2:C7
Click “PivotTable” located on the “Insert” tab.
Click “OK” to accept the default settings.

5. Drag each column
heading into the
“Values” area.

6. Drag “Values” from
Column Labels to
Row Labels.

You should have the
PivotTable shown to the right.
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MULTIPLE CHOICE/MULTIPLE ANSWER – COUNT THE TOTAL ITEMS SELECTED
CountA() and PivotTables are useful when you want to know how many people selected a particular choice in a
column but what if you were also interested in the number of different combinations selected? For example, how
many selected just one? Just two? All three? The simplest approach is to use CountA() to count the number of
choices for each row and then use CountIF() to count the frequency of each possibility (i.e. 0, 1, 2, or 3).

Solution:

Counting the Number of Choices Selected - CountA() & CountIF()

In this section, we will cover how to count the number of people who selected no choices, just 1 choice, just 2
choices, and all three choices of a multiple choice question. We will take two steps: first, use CountA() to count
the number of items in each row and then use CountIF() to count the number of 0’s, 1’s, 2’s, & 3’s.
1.
2.
3.
4.

Click the “Mult_Choice_Mult_Answer” sheet.
Click in cell D3.
Type the following formula:
=CountA(A3:C3)
Copy the formula to the remaining rows in column D (D4:D7).
This tells us the number of cells filled for each row (0, 1, 2, or 3).

We will now use CountIF() to count the number of 0’s, 1’s, 2’s, and 3’s in column D.
Syntax: CountIF(Range,"Criteria") (See page 13 for an explanation of CountIF.)
5. Type a 0, 1, 2, and 3 in cells A11, A12, A13, and A14 as shown below. This is our criteria for CountIF().
6. Click in B11 and type: =CountIF(D$3:D$7,A11) (The $ signs are so the cell addresses don’t shift when we copy.)
7. Copy B11 to B12:B14.
The results in B11:B14 indicate the number of people who selected 0 choices, just 1, just 2, and just 3 choices.

Note we could have
also used the
Frequency() function.
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MULTI CHOICE/ANSWER: COUNT & DISPLAY SPECIFIC COMBINATIONS - TABLES
What if you were interested in specific combinations? For example, “How many people selected Autos and Athletics
but not Arts / Entertainment?” Or “How many people selected just Autos?” Further, we would also like to see the
names of the people who made the selections. In this example, we will convert our database to a “Table” to get a
count and use the “Filters” to display only matching criteria and make the count accurate.

Part 1:

Convert the Range to a Table

When you convert a database range to a “Table”, you get several new abilities including filtering & automatic totals.
1.
2.
3.
4.

Click the “Multiple_Choice_With_Tables” sheet.
Highlight from A2:D16 (We want to make sure Excel uses the question text as our column headings.)
Click the “Insert” tab and then the “Table” button.
Click “OK” to accept the data range you highlighted for the table.

Excel will band your rows and display a Design tab if you are clicked within your table.
5. Click within your table and then click the “Design” tab and check “Total Row” to make
a total appear below the table.

6. Click in the last row, you
will get a drop down that
you can select different
functions you wish to apply
to the column. Select
“Count” in this example.
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Part 2:

Filter the Table and Count

“Filter” can be used with a table or database to hide all but the desired data on a column-by-column basis. In this
example, we wish to see responses where the person selected Athletics and Autos but nothing else. This means
that there is a blank in the “Arts/Entertainment” column but nowhere else.
7. Use the drop down arrows next to the column headings to create filtering combinations. For example to see
just Athletics and Autos, do the following:
a. Click the “Athletics”
arrow and check
just “Athletics”.

b. Click the “Arts/
Entertainment” arrow and
check just “Blanks”.

c. Click the “Autos”
arrow and check
just “Autos”.

Excel should now be displaying just those people who selected Athletics and Autos but not Arts/Entertainment.
It should also be displaying the total count in the bottom row.

Disadvantage of Tables
The only problem with this method is that you have to change your criteria for each combination you wish to
analyze. This means that you will not be able to more than one combination at the same time. See the next
section on Array Formulas to display the results without having to change the criteria. Note that Array
formulas will give you answers only, they will not display rows.
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MULTI CHOICE/ANSWER: COUNT SPECIFIC COMBINATIONS – ARRAY FORMULAS
Using an array formula to count different answer combinations is useful when you don’t need to see any names
associated with the results. Further, unlike the Tables method shown above, we don’t have to keep adjusting our
criteria if we wish to see a particular combination. As with the previous example, we are interested in
combinations of responses. For example, how many people selected just Athletics? Or Athletics and Autos but not
Arts/Entertainment? The syntax of the array formula we will use to solve these questions is shown below.

Syntax: =Sum((Condition1)*(Condition2)*(Condition3)*(Condition…))
The trick to an array formula is that you must press “CONTROL” + “SHIFT” + “ENTER” simultaneously after typing or
editing it rather than pressing just enter alone. If you just press Enter as you would with a non array equation you
will get an error or the wrong answer.

Array Example 1: Just Athletics
Using the spreadsheet above, we wish to count the number of people who selected Athletics but nothing else.
1. Click the “Mult_Choice_with_Arrays” sheet.
2. Click in a blank cell below your data and type the formula below but don’t press Enter.

=SUM((B3:B16="Athletics")*(C3:C16<>"Arts/Entertainment")*(D3:D16<>"Autos"))
3. Press Control + Shift + Enter

You should get 4 people selected just Athletics.

Array Example 2: Autos & Athletics but not Arts / Entertainment
Using the spreadsheet above, we wish to count the number of people who selected Autos and Athletics but not
Arts / Entertainment.
1. Click in a blank cell below your data and type the formula below but don’t press Enter.

=SUM((B3:B16="Athletics")*(C3:C16<>"Arts/Entertainment")*(D3:D16="Autos"))
2. Press Control + Shift + Enter

You should get 3 because this combination exists 3 times.

Array Example 3: Selected All Three
We wish to count the number of people who selected Autos, Athletics, and Arts / entertainment.
1. Click in a blank cell below your data and type the formula below but don’t press Enter.

=SUM((B3:B16="Athletics")*(C3:C16="Arts/Entertainment")*(D3:D16="Autos"))
2. Press Control + Shift + Enter
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How Does the Array Formula Work?
There are three concepts that you must know to understand how these array formulas work.
a. Pressing Control + Shift + Enter allows Excel to process numbers in a range individually rather than in
aggregate. For example, it first runs B3, C3, & D3 through the equation, then B4, C4, & D4 and so on. Once it
has exhausted all of the cells in the range, it works its way out and the Sum( ) function kicks in.
b. When you give Excel a condition to evaluate such as: B3=”Athletics”, it will return either True or False
depending upon whether or not cell B3 actually contains the text Athletics. To a computer, True=1 and
False=0.
c. Zero times any number is zero.

Let’s see how Excel processes this equation.

=SUM((B3:A16="Athletics")*(C3:C16<>"Arts / Entertainment")*(D3:D16<>"Autos"))
First, it substitutes in the contents of B3, C3, & D3) into the equation:
=SUM((Athletics="Athletics")*(Arts / Entertainment<>"Arts / Entertainment")*(Autos<>"Autos"))
Next, it evaluates each condition as either true or false and uses 1 for true and 0 for false:
=SUM((1)*(0)*(0)) evaluates to 0 because 1*0*0 is equal to zero.
It does this for each row, substituting in the values, and then returning either 1 or 0 depending if the condition is
True or False. The only time it will return 1 is for row 5 because all conditions are True:
=SUM((Athletics="Athletics")*(Arts / Entertainment<>"Arts / Entertainment")*(Autos<>"Autos"))
=SUM((1)*(1)*(1)) evaluates to 1.
Once each row has been evaluated, the Sum( ) function is activated. It now contains a series of 0’s and 1’s as
shown:
=SUM(0,0,0,0,1,0,0)
When Sum( ) adds up all of its 1’s and 0’s, it returns 1.
Conceptually this may seem more complicated than other methods but the structure is really very simple to
create. What’s nice about it is that if you have more conditions, you simply place them inside of the Sum()
equation.
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IsBlank() & IsText() Variation on an Array Formula
“Athletics” and “Autos” are pretty short and are not a lot of trouble to type into our array formula but if we had
longer criteria to evaluate, the door opens a little wider for typos which would give us the wrong answer. Instead,
try using IsBlank( ) and IsText( ) in your conditions.
IsBlank(range)
IsText(range)
IsNumber(range)

This function looks to see if a cell is blank or not. If it is blank, it returns True (1). If it isn’t
blank, it returns False (0).
This function looks to see if a cell contains text. If it does contain text, it returns True (1). If it
doesn’t contain text, it returns False (0). Note that a number is not considered text.
Though not applicable to this example, this function looks to see if a cell contains a number. If
it does contain a number, it returns True (1). If it doesn’t contain a number, it returns False
(0). It would be useful if you had exported your answers as values.

Here are the three examples from the previous page again only this time we are using IsBlank() and IsText().
Basically, substitute IsText() for text matches and IsNull( ) for blanks.
Again, make sure you press Control + Shift + Enter after typing or editing array formulas.
Example1 (Athletics Only):

=SUM((IsText(B3:B16))*(IsBlank(C3:C16))*(IsBlank(D3:D16)))

Example 2 (All three):

=SUM((IsText(B3:B16))*(IsBlank(C3:C16))*(IsText(D3:D16)))

Example 3 (Athletics or Autos):

=SUM((IsText(B3:B16))*(IsBlank(C3:C16))*(IsText(D3:D16)))

Another Variation
As another variation on our array formula, you can also type the three possible choices in cells and then use those
cell addresses in the formula. To set criteria, simply delete one or more of the items to create blanks.
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MATRIX QUESTIONS
This question type allows you to specify a rating for each row item. For example, for Instructor you can select from
Very Bad to Very Good and the same is true for Content and Facilities.
When single answer matrix questions are exported to Excel, each row statement from the survey is placed in its
own column. In our question we asked the user to rate three items (Instructor, Content, and Facilities) so we got
three columns in Excel. To identify each column, Qualtrics places the statement after the question (i.e. “Please rate
each item. – Instructor”, “Please rate each item. – Content”, “Please rate each item. – Facilities”)
A single row pertains to a single response. For example, Tom thought the Instructor was “Very Good”, the Content
was “Good”, and the Facilities were “Neither Good nor bad”.

Answers as Values
When analyzing matrix questions, people are usually interested in averages, standard deviations, etc,
therefore, you may find your analysis easier if you export your answers as values. In this example, Very Good
becomes 1, Good becomes 2, etc.
Recode Values
If you wanted to reverse the scale (i.e. 5 becomes Very Good, 1 is Very bad, etc.), or provide a different scale
such as 1-10, your easiest option is to use the “Recode Values” options in Qualtrics prior to exporting. This is
shown on page 10.

© Marshall School of Business - Wayne Wilmeth

Survey_Analysis_Using_Excel.docx

10/21/09

Page 23 of 47

MATRIX QUESTION ANALYSIS – AVERAGE
Because analysis on matrix questions typically includes averages, standard deviations, etc, I strongly suggest that
you export your answers as Values. To perform your analysis, you can use most of the tools covered in pervious
examples including:
 Pivot Tables
 Tables
 Array Formulas
 CountIF(), CountA(), Frequency()
Because statistical analysis is most often used with Matrix questions, in this section we will introduce Average(),
AverageIF(). We will also show an array method to get the average and PivotTables.

Example 1: Finding the Overall Average – Average()
If you want to know the overall average rating for a class, use Excel’s Average() function. This one is simple if you
exported as values.
Syntax:

=Average(Range)

1. Click the “Matrix_As_Values” sheet.
2. Click in a blank cell (C19 for example).
3. Type the following and press enter: =Average(B3:D16)
You should get 2.44 as the average.

Note that the Average() function will
ignore blank cells but if a cell contains a
zero, it will include the 0 in the
calculations to get the average.

Example 2: Average for Just Instructor
If you wanted the average for a particular column only, (Instructor, Content, or Facilities), you would simply limit
your range to just one of those columns.
For example to get the Instructor’s average, the formula would be:
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Example 3: Find the Instructor Average Based on a Criteria – AverageIF()
Like Average(), AverageIF() will the average of a set of numbers but only if they match a given criteria. In this
example, we wish to find the average rating the Instructor received but only from “Grad” students.

=AverageIF(Criteria Range,"Criteria",Range of Cell to Average)
This is a cell or range of
cells which contains
labels or values that the
criteria will evaluate.

This is a cell address,
label, value, or Boolean
equation which does
the evaluation.

These are the cells to average
assuming they meet the criteria.
If Criteria Range is omitted, this
area is used as the Criteria Range.

Grad Average
1. Click the “Matrix_AverageIF” sheet.
2. Click in any blank cell (C19 for example) and type:

=AverageIF(A3:A16,"=Grad",B3:B16)
3. Press enter. You should get 2.11
Undergrad Average
4. To get the Instructor average for Undergrads, click in cell C20 and type:

=AverageIF(A3:A16,"=Undergrad",B3:B16)

Note that AverageIF()cannot
find the average of more than
one column. For example, you
can’t use it to get the average
for Instructor, Content, and
Facilities. See the Average
Using an Array formula for
that.

5. Press enter. You should get 2.75
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Example 4: Find the Overall Average Based on a Criteria – Average AverageIF()s
In this example, we wish to find the overall average from Grad students for all three columns combined (i.e.
Instructor, Content, and Facilities). Unfortunately, we can’t use AverageIF() for this because AverageIF() cannot
evaluate multiple columns of data; however, you can use =AverageIF()to find the average of each of the three
columns individually and then use Average() to average the AverageIF()s together.

The basic structure would be:

=Average(AverageIF(),AverageIF(),AverageIF())

1. Click the “Matrix_AverageIF” sheet.
2. Click in a blank cell (C21 for example) and type:
=Average(AverageIF(A3:A16,"Grad",B3:B16),AverageIF(A3:A16,"Grad",C3:C16),AverageIF(A3:A16,"Grad",D3:D16))
3. Press enter. You should get 2.3
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Example 5: Find the Overall Average Based on a Criteria – Array Formula
In the previous example, we found the overall average of just Grad students by nesting an AverageIF() for each
column inside of the Average() function. This works fine with just a few columns but if you have many, the
nesting can get fairly lengthy. As an alternative, this example solves the same problem using an array formula.
(It will also impress the cool kids.)
1. Click on the “Matrix_Array_Average” sheet.
As you can see, there are a few more columns that we wish to include to find the average score by just Grad
students.

2. Click in a blank cell (C18 for example and type the formula below.
3. Be sure to press CONTROL + SHIFT + ENTER after you are done typing. You should get 2.16

=SUM(((A3:A16)="Grad")*(B3:F16))/SUM((A3:A16="Grad")*ISNUMBER(B3:F16))

Sum All Grad Values
This section adds all of the values for Grad
students only together.
The purple code checks to see if the
current cell in column A contains the
word “Grad” and returns a 1 if it does and
a 0 if it does not. The resulting 1’s and 0’s
are multiplied by the corresponding cell in
the green range (B3:F16). Because 1
times a value is the value and 0 times a
value is 0, you wind up with a bunch of 0’s
and values. Sum() then adds all of the 0’s
and values up to get a total.

Count of Grad Responses
This section counts the number of number of responses
by grad students.
The purple code checks to see if the current cell in
column A contains the word “Grad” and returns a 1 if it
does and a 0 if it does not. IsNumber() checks to see if
each corresponding cell in the range contains a number.
If the cell does contains a number IsNumber()returns 1;
If it does not, it returns 0. The corresponding results
from our comparison and IsNumber()are multiplied
together so you get a bunch of 1’s for cells which
contain numbers and 0’s for cells which are blank.
Sum() then adds all of the 1’s and 0’s together to get a
total count of the Grad cells which contain values.

Sum of Grad Values / Count of Grad Values
Finally, we divide the sum of all grad values by
the number of grad responses to get an average.
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Example 6: Find a Column Average Based on Multiple Conditions - AverageIFS()
If you need to find the average of a single column of cells based on multiple conditions, you can use the
AverageIFS() function. Note that the numbers you are averaging cannot be a block – it must be a single column.

=AverageIFS(Range to Average, Criteria Range 1,Criteria 1, Criteria Range 2,Criteria 2, …)
This is the
range of cells
whose
average you
wish to find.

This is the range
of cells whose
data will be
considered in
the criteria
evaluation.

This is the
criteria
evaluation. It
uses the cells
in the Criteria
Range.

These are optional
additional criteria. They
are comprised of a
Criteria Range and a
Criteria.

In this example, we wish to determine the average salary of Males who are age 50 or over.
1. Click the “AverageIFS” sheet.
2. Click in cell D17 and type the function below and press enter.

=AverageIFS(C3:C14,A3:A14,">=50",B3:B14,"=Male")
You should get 42,500.
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COUNT RESPONSES MATCHING MULTIPLE CRITERIA - COUNTIFS()
You can use CountIFS() to count the number of responses which match multiple conditions. For example, how
many of our respondents where Males greater or equal to age 50?

=CountIFS(Range to Count,Criteria 1,Criteria 2, Criteria 3, …)
This is the
range of cells
you wish to
count

This is the
criteria
evaluation. It
evaluates the
cells in the
Range to Count.

These are optional
additional criteria
evaluations.

1. Click the “AverageIFS_Salary” sheet.
2. Click in a blank cell (D19 for eample).
3. Type the function below and press enter. You should get 2.

=COUNTIFS(A3:A14,">=50",B3:B14,"=Male")
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COUNT OF ITEMS GREATER THAN AVERAGE
In these examples, we wish to count the number of items which are greater than the average or less than the
average. There are several methods we could use for this:
 Tables using the “Above Average” filter.
 Using a combination of an IF(), Average(), and Sum().
 An Array Function.
 PivotTables by finding the average and then filtering by a hard coded average.
 Advanced Filter and DCount()

Solution 1: Count Salaries Greater than the Average Salary - Tables
This is probably the easiest solution. Not only does it count for you but it also allows you to use criteria if desired
and see the matching records. Its only drawback is that if you wish to change your criteria to find a different
solution, your previous solution is no longer valid.
1.
2.
3.
4.
5.
6.
7.
8.

Click the “Over_Average” sheet.
Highlight A3:D14.
Click the “Table” button located on the “Insert” tab.
Click “OK” to accept the range A3:D14 and make sure “My table has Headers” is checked.
Click inside of your table to make the “Design” tab appear.
Check “Total Row” on the “Design” tab.
Click the filter for the “Salary” column.
Select “Number Filters” and then “Above Average”.

9. Set the “Total” row to “Count”.
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Solution 2: Count Salaries Greater than the Average Salary – IF(), Average(), & Sum()
Conceptually, this is a fairly simple solution: We will use IF() to place a 1 next to any salary that is greater or equal to
the average and then use sum() to add up all the 1s to get a count of all the number of salaries greater than average.
We will also use the Average() function to determine the average. It will be nested within our IF() statement. Its
advantage is that we don’t have to filter our database. Its disadvantage is that it will not hide records which don’t
match our criteria.

=IF(Condition,True,False)
Condition determines whether the code in the True of False
section will be executed. Condition must contain an
equation or function that returns either true or false.

Both True and False can contain
a value, text in quotes, a cell
address, or a formula/function.

1. Click the sheet: “Over_Average_If”.
2. Click in cell D3.
3. Type: =if(C3>=Average(C$3:C$14),1,0)
4. Copy D3 to D4:D14.
(You should get 1s next to any number which is greater or equal to the average.)
5. Click in cell D16.
6. Type: =Sum(D3:D14)
(This sums all of the 1’s giving you the number of salaries greater or equal to the average.)
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About Solution 2: Nesting The And() Function Within An If() Function
In the previous example, we nested an AND() function within an IF() function. This section explains the concept.
About IF() statements
The IF() function returns one of two possibilities depending upon whether or not a condition is true or false.
Syntax:
Example:

=IF(Condition,True,False)
=IF(A2>=10,"10 or more","Under 10")

Would return “10 or More” because the condition is true.
(20>=10 is true so the “True” section is activated.)

About AND() function
This function returns either “True” or “False” and is often inserted into the Condition section of an IF() statement.
Syntax:
Example:

=AND(Condition1,Condition2,Condition3,Condition4,…)
=AND(C2>=A2,C2>=B2,C2>=D2)

If all of these conditions are true, AND() will return “True”. If any one of them is false, it will return “False”.

Solving our Example
In the example on the previous page, we nested the AND() function in the condition section of our IF() function.
When True, IF() will return 1; when False, IF() will return 0. We will then add up all of the 0’s and 1’s to see how
many people gave their highest percentage to Mortgage/Rent.
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Solution 3: Count Salaries Greater than the Average Salary – Array Formula
In this example we will use an array formula to count the number of salaries greater or equal to the average. Its
advantage is that it is the least intrusive because it all takes place in one cell and does not require filtering the
database. It also allows multiple criteria. Its disadvantage is that array formulas can be conceptually difficult and
that it does not show matching records.
1. Click the sheet: “Over_Average_Array”.
2. Click in cell F2.
3. Type the array formula below and press Control + Shift + Enter.

=SUM((C3:C14>=AVERAGE(C3:C14))*1)

I’m not sure why but you
need to multiple the
expression by 1 to get an
answer.

You should get 6.
If you would like to count just the female respondents whose salary is
greater than the average, type the equation below and press Control +
Shift + Enter.

=SUM((C3:C14>=AVERAGE(C3:C14))*(B3:B14="Female"))

Note that this last example did not find just the average of female salaries, it was the average of all female
and male salaries. If you wanted the average of just female salaries and then the number of salaries greater
or equal to that average, you could use the following array formula:
=SUM((C3:C14>=AVERAGEIF(B3:B14,"Female",C3:C14))*1)
Or
=SUM((C3:C14>=SUM((B3:B14="Female")*(C3:C14))/SUM((B3:B14="Female")*1))*1)
Remember, you must press Control + Shift + Enter after typing or editing an array formula.
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FIND THE MOST FREQUENTLY OCCURING VALUE – MODE()
You can use Excel’s Mode() function to find the most frequently occurring number. It is useful for any question
type which returns values.
1.
2.
3.
4.

Click the “Mode_&_Stdev” sheet.
Click in cell C19
Type the following: =Mode(B3:D16)
Press Enter. You should get 2.

FINDING THE LARGEST OR SMALLEST VALUE IN A RANGE: MAX() & MIN()
Excel’s Max() function will return the largest value in a range and the Min() function will return the smallest.

Finding the Largest Value: Max()
1. Click the “Mode_&_Stdev” sheet.
2. Click in Cell C21.
3. Type:

=Max(B3:B16) and press enter.

Excel should return 4

Finding the Smallest Value: Min()
1. Click the “Mode_&_Stdev” sheet.
2. Click in Cell C22.
3. Type:

=Min(B3:B16)

and press enter. Excel should return 1

© Marshall School of Business - Wayne Wilmeth

Survey_Analysis_Using_Excel.docx

10/21/09

Page 34 of 47

MATRIX ANALYSIS - STANDARD DEVIATION
Standard deviation tells you how similar your responses were. Was everyone’s response to the survey mostly the
same or did they have widely varying responses where one person gave all 1’s and another person gave all 5’s?
Syntax:

=Stdev(Range)

1. Click the “Mode_&_Stdev” sheet.
2. Click in a blank cell (D20 for example).
3. Type: =Stdev(B3:D16) and press enter.
You should get about 1.12 when means that assuming a standard bell curve, 68% of the response were within 1.12
of the average or if you do the math, between 1.32 and 3.56. (i.e. 2.44-1.12=1.32 and 2.44+1.12=3.56). See the
section below for an explanation of Standard Deviations and the Normal Curve.
Interpreting Standard Deviation
Standard Deviation is a somewhat abstract concept used to determine how disperse your data is from the average
(mean). A low standard deviation indicates that most of the values are similar while a high standard deviation
indicates that they vary more widely. Results for surveys typically follow a bell curve (normal distribution) where
most of the data is close to the average with fewer responses further away from the average. The image shows this
graphically.
99.7%
95%
68%

-2.1%
3 STD

-13.5%
2 STD

-34%

1 STD

34%
0
Mean

13.5%
1 STD

2 95%
STD

2.1%
3 STD

The concept of Standard Deviation slices up the normal curve into deviation groups. In the normal curve, most of
the responses are within 34% of the mean (either higher or lower) creating a group of 68% of the respondents
(34+34=68). The 34 percent to each side of the mean is known as 1 standard deviation.
The next group is further away from the mean and is comprised of about 13.5% of the respondents on either side of
the mean. This is known as 2 standard deviations. Finally, about 2.1% of the responses are the furthest away from
the mean and is known as 3 standard deviations.
Going back to our example above, we got a standard deviation of 1.12 which means that 68% (1 standard deviation)
of the responses where within 1.12 points of the average.
It also means that most of our responses (95% or 2 standard deviations) were within were within 2.24 points of the
mean (1.12 * 2).
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CREATING & EXPORTING A CONSTANT SUM QUESTION IN QUALTRICS
This allows you to either type in numbers in boxes or drag bars to rate each item on a given scale. Typically, the
numbers should add up to 100 but the maximum is adjustable.

When exported to Excel, each row item gets its own column. Be
sure to export these as “Values” or your answers for this question
type will be meaningless. Also, see the previous page for a
method to narrow your question text for the export.

Specifying the Maximum Total
If you would like to specify a number that the sum of the bars or
boxes must sum to, follow the steps below.
1.
2.
3.
4.

Click the question to be affected.
Click its purple box and then select “More Advanced Options”.
Click the “Options” tab.
Type the number you wish the boxes or bars to sum to in the
“Choices must total” box.
5. Click “Save Question”.
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Q1:

Which Item has the Highest Percent?

The simplest method is to sum each column.
1. Click the “Constant_Sum” sheet.
2. Click in cell B12 and type:

=Sum(B2:B11)
3. Copy the formula to the right.
The column with the largest number is
the one with the highest percent.

Q2: How many times was Rent/Mortgage more than 50% of the total income?
1. Click the “Constant_Sum” sheet.
2. Click in cell B15.
3. Type this equation:

=COUNTIF(B3:B11,">=50")

Q3: How many times was Rent/Mortgage the Maximum Value? - AND() & IF()
We will place a 1 to the right of any row where Mortgage/Rent is the largest value in the row by nesting the AND()
function within an IF() function and then we will sum up all of the 1s.
1. Click the “Constant_Sum” sheet.
2. Click in cell E3 and type:
3. Click in cell E12 and type:

=IF(AND(B3>C3,B3>D3),1,0)
=Sum(E3:E11)

Q3a: How many times was Rent/Mortgage the Maximum Value? - Array Formula

=SUM((C2:C5>=A2:A5)*(C2:C5>=B2:B5)*(C2:C5>=D2:D5))
(Remember to press Control + Shift + Enter)
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RANK ORDER
This question type allows you to rank items by using your mouse to drag the choices up and down. When
exporting to Excel, each row item gets its own column.

1. Click the “Rank_Order” sheet.
Rank Order questions export to excel with each choice in its own column and the rank each person gave the
choice below it. For example, the first person in this example (row 2) rated Ice Cream #4, Chocolate Cake #2,
Fruit Salad #3, and Pecan Pie as their #1 choice. The remaining responses are in the rows below.

Top Two Items - Sum() and Average()
There are several different methods you could use to analyze your
results. For example, if you just wanted to select the top two
choices, you might want to use Average() or Sum() and then take
the two lowest values as the winners.
1. Click in cell B9 and type:
=Sum(B2:B7)
2. Click in cell B10 and type: =Average(B2:B7)
3. Copy B9 & B10 to the other cells in their rows.
Ice Cream has the lowest sum (12) and average (2) followed up by
Pecan Pie (13) and (2.2).
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Rank Order Analysis – Frequency()
If you wanted to know how many people rated each dessert as their #1 choice, #2, #3, and #4, the Frequency()
function is ideal for that. Note that this is an “Array” function which means that we can get multiple results at once
by highlighting multiple cells prior to typing our formula and that you must press Control + Shift + Enter.

Frequency(Data Array, Bins Array)
This is the column of data you are
analyzing; for example, all of the
values in the Ice Cream column.

This is a range of cells you must create which contains the
values you wish Excel to group by. For example, we wish to
know how many 1s, 2s, 3s, and 4s are in each column so we
would make a range containing 1, 2, 3, & 4.

2. Highlight B13:B16.
3. Type the following:
1. Create your Bins
Array by typing a 1
in A13, a 2 in A14,
a 3 in A15, and a 4
in A16.

=Frequency(B2:B7,$A13:$A16)
4. Press Control + Shift + Enter
This should have filled in B13:B16.

5. Highlight B13:B16 and copy the
array to apply it to the other
columns as shown below.

For each column, the results tell you how many people rated an item as their first, second,
third and fourth choice. For example, in the Ice Cream column, 4 people picked it as their
#1 choice, 0 people as their #2, 0 people as their #3, and 3 people as their #4 choice.
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Rank Order Analysis – PivotTables
This gives you the same results as using some only it does it with a PivotTable. The structure you would use is
shown below.
1. Highlight B1:E7.
2. Click the “Insert” tab and then “PivotTable”.
3. Click “OK” and then structure the PivotTable as shown below.
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COLLECTING DATES
There are a couple of options you can use when you need to collect date information from your responders: Open
Ended Questions and Side-by-Side Questions. Both allow you to collect hire dates, expiration dates, birthdates, etc.;
however, if you are working with international responders who may be used to a different date foramt, you should go
with the side-by-side model to insure accuracy.
Open Ended Question
This is the easiest to create and analyze in
Excel but does not prevent users from
switching the month and day.
Side-by-Side Question
This is more time consuming to create and
analyze in Excel but it does make it more
clear to the user where to put the day and
where to put the year.

Collecting Dates Using an Open Ended Text Question
When using this method, your user will type the date into a text box as so:
2/25/2008 You can use validation to ensure that the date is typed in this
format: mm/dd/yyyy This method is useful when you know all of your
responders are used to typing dates in the mm/dd/yyyy format but can give
you bad data if your responder is from a country which uses the
dd/mm/yyyy format. Even with validation a user could type February 8th,
2008 like this: 02/08/2008 or like this: 08/02/2008 and you could end up
with inaccurate information.
The validation area (shown to
the left) is accessed by clicking
the purple drop down and
selecting “More Advanced
Options”.
The question exports to Excel as
shown below.
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Collecting Dates Using a Side-by-Side Question
When it comes to accuracy, this is the more reliable method of collecting dates because it gets around the
mm/dd/yyyy or dd/mm/yyyy issue by using drop downs; however, creating the question and analyzing the data is
more time consuming.

Steps for Creating a Side-By-Side Question to Collect Date Data
1. While on the “Edit Survey” tab, click the “Create a New Question” button.
2. Click the green “Change Question Type” button and then click “Side By Side”.
You will get a question similar to the one shown below. We need to have just one
row (Statement 1) and three columns (Heading 1, Heading 2, and Heading 3)
3. Click the “Click here to edit question” link. All work must be done in this area.

4. Click on the “Question” tab and type the question’s text.
5. Click the “Choices” tab
6. Click the “Go to Advanced Mode” button.
7. Type the question text for statement 1.
8. Check statements 2 & 3 then click the “Delete” button.
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8.
9.
10.
11.

Click the “Side-By-Side Questions” tab.
If necessary, click the “Add” or “Delete” button at the bottom of the screen to get a total of three questions.
Make the settings indicated below in steps a-f.
Complete steps a-g below then click the “Save Question” button located at the bottom of the screen.
a. Type Month
here.
b. Type the
months.
(See the note
below on
acceptable
choices for
Excel.)

c. Type Day
here.
d. Type the day
numbers
here (1-31). *
e. Click the
“Add +”
button.
f. Type Year
here.
g. Type the
years here.

Note on Acceptable Month Choices for Excel
While you can successfully export the month names to Excel using any type of spelling you desire, if you wish to
recombine them into a single usable field that you can manipulate later within Excel, you should use one of the
conventions listed below.
Full Month Names
If you want the full names of the months on the drop downs, use the spelling below on your list:
January, February, March, April, May, June, July, August, September, October, November, December
Month Abbreviations
If you want abbreviated month names on the drop downs, use the abbreviations below on your list:
Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec
Month Numbers
If you want to use month numbers on the drop downs, use the following: 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12
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Exported as Labels to Excel
When exported as labels to Excel, the three parts (Month, Day, Year) will appear in separate columns as shown
below. Note that exporting as values would convert the months from Jan-Dec to 1-12 but it would also convert the
years (i.e. 2008 becomes 1, 2007 becomes 2, etc. so be sure to export as labels.

Combining the Separate Date Parts into a Single Cell
If you wish to join the date information (month, day and year) into a single cell in typical Excel data format, there
are two steps involved:
1. Use the concatenation character “&” to join the date in an acceptable Excel date format.
2. Paste as values to convert the formula to a value.
Step 1: Combining the Date Parts Using “&”.
You can use the ampersand to make items in separate cells appear next to each other in a single cell. If you wish to
add extra characters such as dashes or slashes, they must be in quotes. Note that if we wish to use Excel to
manipulate the combined date later, then we must combine them using one of Excel’s existing date formats.
Because we used abbreviations, this is the only date format available: 14-Mar-2001 (i.e. day-mon-year)
1. Click the sheet: “Combining_Date_Parts”.
2. Click in cell and type: =A3&"/"&B3&"/"&C3
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Step 2: Converting the Combined Dates from a Formula into Values
Although the date parts now appear in a single cell, it is really a formula. If you would like to convert it to an actual
data value rather than a formula, follow the steps below. Converting it to an actual date value rather than a formula
will allow you to perform more operations on the cell such as changing the date format.
1. Highlight the formulas you typed in “Step 1”.
2. Right click the highlighted area and select “Copy”.
3. Click a destination cell for the copied block.
Excel 2007 Users
a. Click the “Home” tab.
b. Click the “Paste” drop
down arrow.
c. Click “Paste Values”.

Excel 97-2003 Users
a. Click “Edit” from the menu.
b. Click “Paste Special”.
c. Select “Values” & click “OK”.

The contents of the cells you copied to will look the same as the data in the cells you copied from; however, you if
you click one of the cells you copied to and look on the editing bar, there are no formulas, just the value.
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CONVERT LABELS TO VALUES: FIND & REPLACE
Most survey questions which involve ranking are exported as values to make mathematical manipulation and
analysis easier. However, if for some reason you are only able to export as labels or perhaps someone provided you
a spreadsheet where there responses were exported as labels, you can use Excel’s “Find and Replace” feature to
convert your labels to values.
1. Click the sheet: “Find&Replace_Labels”.
2. To limit the area where Find & Replace take place, highlight B3:D16.
In this spreadsheet, we wish
to convert our labels to
values as follows:
Very Bad = 1
Bad = 2
Neither Good nor Bad = 3
Good = 4
Very Good = 5

3. Click the “Home” tab.
4. Click the “Find & Select” button and then click “Replace”.

5. Click the “Options” button.
6. Check “Match entire cell
contents”.
(If you don’t check this,
when you replace “Very
Good” with a 5, you will
replace “Good” with a 5 as
well.)
7.
8.
9.
10.

In the “Find What” box, type: Very Good
In the “Replace With” box, type: 5
Click the “Replace All” button and then click “OK” at the message box.
You would now repeat steps 7-9 four more times except in the Find What and Replace With boxes, you will be
using:
 Good & 4
 Neither Bad nor Good & 3
 Bad & 2
 Very Bad & 1

© Marshall School of Business - Wayne Wilmeth

Survey_Analysis_Using_Excel.docx

10/21/09

Page 46 of 47

HOW OPEN ENDED TEXT EXPORTS
This question type allows the user to type text into a box containing single or multiple lines.
When exported to Excel, one column
will be used to store all of the
responses. In the example shown,
three different people have taken the
survey.
Note that the maximum number of characters in a cell for Excel 2007 is
32,757.

HOW MULTIPLE CHOICE DROP DOWN LISTS EXPORT
This question type allows the user to select a choice from a list. The question and results will export to Excel in a
single column.
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